QuickBooks®
Customer Manager V3

Installation and Upgrade
Guide

IMPORTANT !
Read this before installing or
upgrading your software
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Welcome!

In this booklet you will find everything you need
to know to get up and running with QuickBooks
Customer Manager V3.

We strongly recommend that you read this booklet
carefully and follow the steps outlined to ensure your
installation process is as smooth as possible.

Note: You need to uninstall any previous version
of Customer Manager (including any trial versions)
before installing QuickBooks Customer Manager V3.
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System Requirements

+ 350 MHz Intel Pentium (or equivalent) with 96 MB of RAM
(1.0 GHz Intel Pentium IV or equivalent with 256 MB of
RAM recommended)

« Windows 2000/XP/Vista™ *

170 MB of disk space for Customer Manager installation**

« Internet Explorer 6.0 or 7.0 (requires 70 MB)

+ Atleast 256 colour SVGA video

+ 800 x 600 resolution with small fonts (1024 x 768
resolution recommended)

+  Works with any printer supported by Windows 2000/XP/
Vista™

+ 8 x CD-ROM Minimum

« All Online features/services require Internet access with

at least a 56 Kbps modem (High speed Internet access
recommended)

* Not available on 64 Bit Operating System

** QuickBooks QB series system requirements are higher than QuickBooks Customer
Manager. Please ensure that you make a note of these prior to installing your software. The
system requirements for QuickBooks QB series can be found in the QuickBooks QB' series
startup guide.

Integration Requirements
+ Microsoft® .NET Framework CLR 1.1 (provided on CD,
requires additional 23 MB of hard disk space)

QuickBooks EasyStart, QuickBooks Accounting,
QuickBooks Plus, QuickBooks Pro, QuickBooks Premier
2008/09 QB' series or Quicken 2009

« Microsoft® Outlook 2000, 2002, 2003 and 2007
« Microsoft® Outlook Express 5.5 and 6.0

« Other applications may be imported using a CSV (comma
separated value) or text format file
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Information for Existing Users

Before you upgrade

Before you upgrade to QuickBooks Customer Manager V3,
we strongly recommend that you create a backup of your
current Customer Manager database file.

To back up your Customer Manager database file:
1. Choose File > Backup/Restore > Back up Database.

2. Navigate to where you would like to store the
backup of your database file.

3. Click Save. Make a note of the location of your
backup database file for future reference.

Uninstall any previously installed versions

Before you install QuickBooks Customer Manager V3, you
need to uninstall any currently installed versions (including
trial versions) of Customer Manager before continuing.

If you have not uninstalled your current version, Customer
Manager will prompt you to uninstall the software as part of
the installation process.

Upgrading your database file

When you install QuickBooks Customer Manager V3, your
existing database file will automatically be upgraded during
the installation process. If this doesn’t occur, your database
file will be upgraded the next time that you open Customer
Manager V3.

After you upgrade

It is important to carefully review your customer contact
data, particularly your contact lists and appointments.

If this information is not correct, or not the same as before
the upgrade, you should restore the backup of your previous
version Customer Manager database file.



To restore the backup of your database file:

1.
2.
3.

Choose File > Backup/Restore > Restore Database.
Locate the backup file that you created earlier.
Click Open.

Customer Manager restores your backup file and converts
it to the format required by Customer Manager V3. If the
datais still incorrect, or not as you expect it to be, please
contact Technical Support (refer to Contact Reckon
section).

To synchronise data with QuickBooks:

Before you synchronise (sync) QuickBooks data with
Customer Manager, we recommend that you verify which
QuickBooks version you currently have installed (by opening
QuickBooks and pressing Ctrl + 1 or F2 on your keyboard to
display the product information).

To sync with QB 08/09 series on a PC that has had
earlier versions of QuickBooks installed

For example, your currently installed QB' 08/09 is
upgraded from QuickBooks 07/08. Make sure the
following steps are performed :

1.

Uninstall any versions of QuickBooks earlier than QB!
08/09, and then

Delete Registry folder: - HKEY_LOCAL_MACHINE\
SOFTWAREN Intuit\QuickBooksCommon\
QBFinder

To do this:
a. Go to Start menu and select Run...
b. Typein regedit and click OK

c. From the left-hand scrolling list navigate to

HKEY_LOCAL_MACHINE\SOFTWARE\Intuit\
QuickBooksCommon\QBFinder

d. Select Edit menu and click Delete

e. Select File menu and click Exit to close out of the

Registry Editor



To sync with QB! 08/09 EasyStart, Accounting or Plus

To allow synchronisation you will need to open the
QuickBooks program in the backgroud.

To sync with QB 08/09 Pro or Premier

With QB 08/09 Pro or Premier you do not need to

have QuickBooks program open in order to perform a
synchronisation. The following settings allow Customer
Manager to automatically sync with QuickBooks:

1. In QuickBooks, choose Preferences from the Edit
menu

2. Select Integrated Applications from the scrolling
list

Click the Company preferences tab
Select Customer Manager from the list

Click Properties

o v oW

Select“Allow this application to login
automatically’, and select a user from the drop-
down list, if applicable.

7. Click OK to exit both dialogs
8. Close QuickBooks
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Information for New Users

How to Install QuickBooks Customer Manager

Before you install, please ensure the following;

+ You are logged onto your PC as the Administrator or have
Administrator rights

+ You have shut down all running applications

» Your PCis disconnected from the Internet.

+ You have disabled your anti-virus software and firewall.
If you have anti-virus software and/or a firewall running,
it may prevent you from installing QuickBooks Customer
Manager.

Once you have installed QuickBooks Customer Manager,
re-enable your anti-virus software and firewall and then
reconnect to the Internet.

To install QuickBooks Customer Manager:

1. Insert the QuickBooks Customer Manager V3 CD
into the CD-ROM drive. The installation window will
automatically appear. If this does not happen, select
Run from the Windows Start menu. Type ““d:\
autorun.exe” (where “d” is your CD-ROM
drive) and click OK.

2. Select your region i.e. Australia or New Zealand
3. Click Begin

4. Click Install to install Customer Manager V3.



To synchronise data with QuickBooks:

Before you synchronise (sync) QuickBooks data with
Customer Manager, we recommend that you verify which
QuickBooks version you currently have installed (by
openning QuickBooks and pressing Ctrl + 1 or F2 on your
keyboard to display the product information).

To sync with QB 08/09 series on a PC that has had
earlier versions of QuickBooks installed

For example, your currently installed QB' 08/09 is
upgraded from QuickBooks 07/08. Make sure the
following steps are performed :

1. Uninstall any versions of QuickBooks earlier than QB!
08/09, and then

2. Delete Registry folder: - HKEY_LOCAL_MACHINE\
SOFTWAREN\ Intuit\QuickBooksCommon\
QBFinder

To do this:

a. Go to Start menu and select Run...
b. Typein regedit and click OK

¢. From the left-hand scrolling list navigate to
HKEY_LOCAL_MACHINE\SOFTWARE\Intuit\
QuickBooksCommon\QBFinder

d. Select Edit menu and click Delete

e. Select File menu and click Exit to close out of the
Registry Editor

To sync with QB 08/09 EasyStart, Accounting or Plus

To allow synchronisation you will need to open the
QuickBooks program in the backgroud.

To sync with QB 08/09 Pro or Premier

With QB 08/09 Pro or Premier you do not need to

have QuickBooks program open in order to perform a
synchronisation. The following settings allow Customer
Manager to automatically sync with QuickBooks:

1. In QuickBooks, choose Preferences from the Edit
menu

2. Select Integrated Applications from the scrolling
13



S

list

Click the Company preferences tab
Select Customer Manager from the list
Click Properties

Select “Allow this application to login
automatically’, and select a user from the drop-
down list, if applicable.

Click OK to exit both dialogs

Close QuickBooks
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Customer Manager V3
End User Licence Agreement

THIS IS AN IMPORTANT DOCUMENT. PLEASE READ IT
CAREFULLY.

This is a contract between Reckon Limited (ACN 003 348 730)
(Reckon) and you. By using the Customer Manager software
supplied with this document, and the related user guides and
materials (together the Software), you agree to be bound by the
terms of this Licence. This Licence covers copies of the Software
provided for evaluation or trial purposes, subscription versions and
non-subscription or full versions of the Software. Some Licence
provisions may not be applicable to you, depending on the
particular version of the Software you have purchased or if you are
using the Software for evaluation purposes. The defined terms and
the rules of interpretation in this Licence are set out in clause 12.

Important: There are a number of technical features within
the Software that may affect your ability to continue to use the
Software. These are outlined in more detail in the terms of the
Licence, but in summary:

-you are purchasing the right to use the Software, not to own it;

- if you have been provided with a Trial Version, you may only use
the Software on a temporary basis to evaluate the Software’s
functionality and suitability for your requirements;

- the Software contains registration and activation processes to
guard against illegal copying;

- to continue using the Software, those processes require you
to verify your compliance with the terms under which you
are licensed to use the software (for example: the number of
computers on which the software is installed) and to permit
continued reactivation of the Software from time to time. This
involves, in all versions, periodically verifying your licence details,
and in the subscription version, renewing your subscription
when it falls due. Reckon may also verify subscription customers
during a subscription period and not only at renewal. You will
also need to reactivate your Software if you want to reinstall it
(for example, if you upgrade your computer or if you have a hard
drive failure, and you may incur a technical support cost for this);

-when you purchase the Software or during the course of your
subscription you will be provided with an installation key code.
Please keep the installation key code in a safe place. You may
need it when you first install or re-install (if permitted) the



Software and to reactivate the Software. Please note if you lose
your installation key code that it will not be replaced by Reckon
and you will not be able to install or reactivate the Software;

-you also need a licence key to reactivate your Software. In

addition, with some older versions of the Software, you will not
be able to re-install or reactivate the Software if you do not have
your installation key code - see details below on Reckon’s sunset

policy;

«there will be no charge to activate the Software initially or to

reactivate your Software when you verify your licence details or
renew a subscription. Reckon may charge you a fee for technical
support if it needs to reissue a licence key provided also that the
version of the Software you are using has not been ‘sunsetted’
as explained below. Reckon may also charge a fee if you need to
reactivate the Software in other circumstances (for example, if
you need to reinstall the Software if you upgrade your computer
or due to a hard drive failure);

-if you do not verify your licence details or renew your

subscription (as applicable) within the required period,

the Software may continue to operate but with impaired
functionality or you may not be able to access the Software at all
(including printing out or viewing any of your data or records);
and

«Reckon has a‘sunset policy’ which means that technical support

is not available for some older versions of the Software. This
includes the ability to install or re-install that Software for any
reason if you have lost your installation key code for those old
versions. If you wish to continue using the Software in those
circumstances, you will need to purchase a new copy of the
current version of that Software.

. LICENCE

(a) Evaluation licence: If Reckon has provided a Trial Version of
the Software to you, your rights to use the Trial Version are
solely as set out in clause 10.

(b) Licence to use: Reckon grants you a personal, non-exclusive,
non-transferable, limited licence to use the Software on
the terms of this Licence for the period determined in
accordance with clause 8.

(c) No transfer of copyright: The Software is licensed not sold,
despite any reference to “purchase” or “sale”in this Licence
or in any invoice or purchase order for the supply of the
Software. Reckon reserves all rights not expressly granted
to you. Reckon Limited is the owner of copyright in the
Software and retains ownership of the copyright and all
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other intellectual property rights in the Software and is
protected by copyright law and international copyright
treaty.

2.YOUR PERMITTED USE OF THE SOFTWARE

(a)

(b

=

(c)

Single use licence: If you have purchased a single user licence,
you:

(i) may install the Software once, on one computer
only. However, if you wish to reinstall the Software
(for example, if you need to install the Software on a
replacement computer), then clause 3 will apply; and

(i) must ensure that the Software is used by one person
only at any one time.

Additional licences: Subject to any multi-user licence that you
have obtained, if:

(i) more than one person is to use the Software at the same
time; or

(ii) the Software is to be installed on more than one
computer

then you must obtain an additional licence for each
additional person or computer.

Premier Version

If you have purchased a full version of QuickBooks Premier,
this Licence entitles you to load the Software on up to three
computers (for use by a single processing unit only on each
computer) for use by up to three individuals simultaneously.
If you wish to install the Software on more than three
computers you must purchase additional licenses that will
permit up to five users to simultaneously access a data file.
If Reckon releases the next release of QuickBooks Premier
while you are a member of the Advantage programme
subject to its terms and conditions, you will be permitted to
make a total of five installations.

If you have purchased a subscription version of QuickBooks
Premier, this licence entitles you to load the Software on

up to five computers (for use by a single processing unit
only on each computer) for use by up to five individuals
simultaneously. If you wish to install the Software on

more than five computers you must purchase another

full version or a subscription version of that software but
for simultaneous access you will need to upgrade to an
appropriate version that permits more than five users to
simultaneously access a data file.



(d)

(e)

(f)

(9)

Accountant Edition

If you are an eligible Professional Partner who has purchased
a full version of QuickBooks Accountant Edition, this Licence
entitles you to load the Software on up to five computers
(for use by a single processing unit only on each computer)
for use by up to five individuals simultaneously. In some
special cases with written approval of Reckon only, certain
Professional Partners may be allowed to load the Software
on up to 25 computers. However, only 5 simultaneous users
can have access to any single data file.

Enterprise Version

(i) Ifyou have purchased the QuickBooks Enterprise version
of the Software, this Licence entitles you to load the
Software on up to ten computers with the option to load
up to another 20 computers at the applicable charge (for
use by a single processing unit only on each computer)
for use by up to ten or more individuals up to a
maximum of 30 (as permitted by the Licence purchased)
simultaneously. You may not load the Software onto any
further computers.

(ii) If you have purchased the QuickBooks Enterprise
Accountants version of the Software, this Licence
entitles you to load the Software onto one computer (for
use by a single processing unit). You may not load the
Software onto any further computers.

General restrictions: You must not:

(i) use orrely upon the Software for any purpose or in any
manner for which the Software is not warranted;

(i) copy, reproduce, translate, adapt, vary, merge or modify
or create any derivative work based on the Software;

(iii

reverse engineer, decompile, disassemble, reconfigure
or otherwise attempt to discover the source code of the
Software; or

sell, market, network, transfer, lease, license, sub-
license, rent, lend or otherwise dispose of or distribute
the Software or use the Software to provide a bureau
service.

(iv

Licence verification: Upon written request from Reckon,
including by e-mail, you agree to provide Reckon with a
signed certificate:

(i) verifying that the Software is being used fully in
accordance with this Licence, including user and
machine limitations; and
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(ii) listing locations, types and serial numbers of equipment
on which the Software is run.

You agree to allow Reckon to use and disclose any personal
details provided to Reckon in connection with this Licence
in accordance with Reckon’s then current privacy policy
displayed on Reckon’s website.

(h) Audit rights: Reckon may also audit the number of copies of
the Software in use or possession by you, the equipment on
which the Software is installed or used and the number of
users using the Software. Audits will be conducted in your
normal business hours, or upon reasonable prior written
notice, at Reckon’s expense. If the audit reveals underpaid
or unpaid fees due to Reckon, you will be invoiced for them
based on Reckon'’s then current price list, and if these exceed
5% of the license fees you have already paid, you will also be
invoiced for the cost of the audit.

3. PRODUCT ACTIVATION AND VERIFICATION

(a) Initial registration and verifying licence details: This Software
may contain technology that protects Reckon against illegal
copying. As a consequence, you may be required to:

(i) register your details during the initial installation
(including your name, contact details and details of the
hardware on which the Software will be installed (if this
is not done automatically by the Software);

(i) if you have a full version, have the Software reactivated
periodically thereafter by verifying your licence details to
confirm you are using the Software in accordance with
these Licence terms;

(iii) if you have a subscription version, have the Software
reactivated (on payment of Reckon’s renewal fee and
verification of your licence details) if you wish to renew
the subscription;

(iv) have the Software reactivated by Reckon if you wish to
re-install the Software (for example, if you would like to
install the Software on a new computer or if you have a
hard drive failure and need to reload your Software); and

(v) provide to Reckon the details of your installation key
code and product key code for the Software as part of
the reactivation process.

You agree to activate or reactivate the Software within a
reasonable time or within such time as the Software prompts
you to do so.



(b)

(c)

(d)

(e)

(f)

(9)

Key codes: Each copy of the Software is provided with a
unique installation key code (which may appear on the
packaging or the cover of the media on which the Software
is contained). You should keep the installation key code safe.
As per clause 3(a)(v), you will be required to provide your
installation key code to Reckon when you reactivate your
Software.

Manner of verification: You must verify your licence details

in the manner required by Reckon from time to time (which
may include email or on-line registration via the Internet).
The Software may prompt you as to the required manner of
verification.

Charges for reactivation: Reckon will not charge you to
activate the Software initially or to reactivate your Software
when you verify your licence details or renew a subscription,
unless you have lost your installation or licence key code. You
need both your installation code and your licence key to be
able to reactivate the Software. Reckon may charge you a fee
for technical support to reissue a licence key code. Reckon
may also charge a fee for technical support if you need to
reactivate the Software in other circumstances (for example,
if you need to reinstall the Software because you have a new
computer or need to reload the Software due to a hard drive
failure). For the current fees go to http://www.quicken.com.
au. If you have lost your installation key code, Reckon will not
replace that code, and you may be required to purchase new
Software.

Consequences of non-renewal and failure to verify details:

This Software is provided to you on the understanding and
acknowledgment that it may contain technology which
deactivates and disables the Software if a subscription is not
renewed or in the case of a full licence version, you have not
verified your licence details when periodically prompted to
do so by Reckon or by the Software. If the Software is not
reactivated within the required period, the Software may
continue to operate but with impaired functionality or you
may not be able to access the Software at all (including
printing out or viewing any of your data or records).

Statutory declaration: In certain circumstances, before
permitting a re-activation, Reckon may require you to
provide it with a Statutory Declaration stating the reasons for
re-activation in a form required by Reckon.

Older versions: Reckon has a sunset policy (covered in more
detail in clause 4(a)) which means that technical support

is not available for certain older versions of the Software. If
technical support is not available for your version, you will
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not be able to reactivate or reinstall your Software if you

do not have your registration key code. Reckon will not be
obliged to provide you with a replacement key code and in
those circumstances you will need to purchase a new version
or Upgrade in order to continue using the Software. Please
go to http://www.quicken.com.au to see the sunset policy.

4. TECHNICAL SUPPORT

(a)

(b)

(c)

Period when technical support is available: Reckon will
provide technical support for the Software only (and for the
avoidance of doubt this does not include support for third
party hardware or software, which remains the responsibility
of the relevant third party), during the following periods:

(i) inthe case of a subscription version of the Software,
during the period for which you have paid the relevant
subscription fees (unless further releases of the Software
in question are discontinued); and

(ii) in the case of a full version of the Software, there is a
‘sunset period’during which technical support may not
be available for that version. The sunset period for a
version will commence on the earlier of:

(A) 2 years after the date on which you first installed the
version on your computer; or

(B) the date Reckon releases the second successive
Upgrade to that version.

For further explanation of Reckon’s sunset policy please
go to http://www.quicken.com.au.

What is included as part of technical support: Reckon will
provide technical support in accordance with its then current
technical support policy, which may include:

(i) ascontemplated by clause 3, the technical support
required to reactivate the Software or to issue a
replacement registration key code (for example, when
you verify your licence details, renew a subscription or if
you need to reinstall the Software);

(i) provision of telephone help desk support services;

(iii) access to technical information about the software
contained on Reckon’s website; and

(iv) the ability for you to download Updates,
but it does not include provision of Upgrades of the
Software. For further explanation of Reckon’s technical
support policy please go to http://www.quicken.com.au.
Fees: Clause 3(d) sets out the circumstances when you will

(and when you will not) be required to pay charges for the
technical support to reactivate your Software (including



when you wish to reinstall the Software) or for Reckon to
issue a replacement registration key code.

For all other technical support, Reckon may charge you a fee in
accordance with its then current technical support policy.

5. ONLINE SERVICES

(a)

(b)

(c)

Interaction with Online Services: The Software may contain
access to, or features that interface with, online services
(“Online Services"). Examples of Online Services that may

be applicable to the Software are EFTPOS, an online share
price download facility, a statement download facility, bill
and other payment services, a superannuation choice facility,
online backup facility, payroll services and a debt recovery
facility which are provided at an additional charge on a
subscription basis measured for one year from the date of
registration.

Terms for Online Services: Certain Online Services are not
available for all versions of the Software. For example,

in the case of bank statement download services, not

all banks provide services that connect to the Software.
Online Services are only available for 12-month periods for
subscription versions and 24-month periods for full versions.
In the case of a full version, access to Online Services in the
second 12-month period may be subject to payment of
the applicable charges. In order to renew access to Online
Services at the end of the 24-month period in the case

of a full version, you will be required to have purchased

or upgraded to the latest version of the Software. In the
case of a subscription version, you must have renewed
your subscription. Internet access is required for all Online
Services. Charges may apply for the use of Online Services
(in addition to the cost of Internet access levied by your
ISP). Where Online Services are available, separate terms
and conditions with the provider of the Online Services
may apply. In some cases Reckon may be the provider. You
should check with the relevant third party provider as to
the terms and conditions of use. Access to Online Services
may be withdrawn by Reckon at any time. Reckon will not
be liable for the withdrawal of access to any Online Services.
Where access is to be withdrawn, Reckon may choose to
notify you in advance provided that you have supplied
Reckon with a valid and up to date email address.

Other third party services and applications: In some cases you
may download other third party applications, for example
Google Desktop supplied by Google Inc. In such cases your
agreement to be bound by the terms of this Licence will also
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bind you to the terms of use or other similar agreements
required by such third parties for use of their products.

6. LIMITED WARRANTY

(a)

(b)

(c)

(d)

Software provided on an ‘as is’ basis: Subject to clause 7(b),
Reckon provides the Software to you on an “as is” basis
and without any representations by Reckon or any of its
authorised distributors regarding the use, performance, or
results of the use of the Software.

Defects in media: Reckon warrants that the media on which
the Software is recorded is free from defects in manufacture
for a period of 90 days from the date of delivery. During this
period, if you return the Software to your place of purchase,
Reckon will replace any defective media on which the
Software was supplied and any Software on that media, free
of charge, unless you caused damage to the media due to
poor handling.

No guarantee that Software will be error free or that its use

will be uninterrupted: While Reckon has endeavoured to
make sure that the Software works substantially as per

the specifications published by Reckon from time to time,
Reckon does not guarantee that the Software will work on all
computer hardware platforms or configurations and makes
no warranty that the Software will be error free, that its use
will be uninterrupted or that it will be fit for your purpose.

Internet access, telecommunications networks, firewalls and
security: Reckon does not guarantee connections to its
online activation server as these may be dependent upon
third party networks and security measures over which
Reckon has no control.

7. LIABILITY

(a)

(b)

Certain rights cannot be excluded: The Trade Practices Act,
1974, and other laws may imply certain conditions and
warranties into this Licence and give you certain rights and
remedies that cannot be excluded or modified. This clause
7, and the limited warranties provided in clause 6, do not
exclude or modify any of those rights if to do so would
contravene that law or make any part of this Licence void.

Exclusion of warranties: To the full extent permitted by law,
Reckon excludes all conditions, warranties and rights that
may be implied into this Licence. If conditions, warranties
or other rights for your benefit are implied in this Licence or
otherwise conferred by law and it is not lawful to exclude,
restrict or modify them, then those conditions, warranties
and other rights will (but only to the extent required by law)
apply to this Licence.



(c)

(d)

(e)

(f)

Limitation of implied terms: Reckon’s (and its distributors’)
liability for breach of any implied conditions or warranties
that cannot be excluded is limited, to the extent permitted
by law and at the option of Reckon, to replacing or re-
supplying the goods or services or their equivalent again or
the payment of the cost of having the goods or services or
their equivalent replaced or supplied again.

General exclusion and limitation: Other than as set out in
clauses 7(b) and 7(c), and to the full extent permitted by law:

(i) Reckon (and its authorised distributors) will not be liable
to you or any other person for any direct or indirect
loss, damages, liability, costs or expenses suffered by
you or any other person relating to the performance or
non-performance of the Software or any breach of this
Licence or the supply of the Software or in connection
with, but not limited to, the Online Services, use of tax
tables, use of third party hardware (for example but
not limited to Postec services) or provision of technical
support (whether by telephone or remote access or
other means); and

(i) Reckon’s maximum liability for damages arising in
connection with this Licence or the supply of the
Software is limited to the amount paid by you for the
Software.

Your liability to Reckon: You agree that Reckon (and its
authorised distributors) will not be liable, other than as
expressly set out in this Licence, and that you will indemnify
the Reckon (and its authorised distributors) from any liability,
loss, damage, costs or expenses which you may suffer or
incur as a result of your use of the Software (including any
claims made against you by third parties).

Use of Software is not provision of professional advice: The
information contained in this Software may contain features
designed to assist you in complying with the requirements
of the relevant legislation, eg: superannuation. If the
Software contains features to assist with superannuation,
eg: superannuation guarantee requirements, then Reckon
does not warrant that the relevant reports will be compliant
with legal requirements, as these change from time to time.
You agree it is your obligation to ensure that deductions
and rates used for deductions for superannuation, taxation
(of any nature) and any other deductions/contributions
calculated using the software are correct from time to time
and at the applicable time and that nothing in the software
constitutes professional advice in relation to these matters.
The help contained in this Software is not a substitute for
professional advice. Legal and accounting advice should

be obtained before taking any action in reliance on this
Software. The software is also not financial product advice.
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(9)

(h)

(i)

(a)

In addition any tax tables (which are included with certain
versions of the Software, eg: QuickBooks and Payroll
Premier) that might be supplied with this Software are also
changed from time to time and you should consult with
your professional adviser before relying on the tax tables.
Reckon does not warrant that the tax tables are up to date at
your date of purchase. In providing you with the tax tables,
Reckon is not engaged in rendering legal, accounting or
other professional services. If legal advice or other expert
assistance is required, you should seek the service of a
competent professional.

Reckon has no responsibility for recommendations: Reckon, its
employees, agents, contractors and the authors disclaim any
and all liability and responsibility to any person, whether a
user of this Software or not, in respect of anything (including,
without limitation, any error in or omission from this
Software) and of the consequences of any actions taken or
omitted to be taken in reliance, whether wholly or partially,
upon all or any part of the content, recommendations or
help contained in this Software.

Corruption of data and on-line access: To the full extent
permitted by law, Reckon and its authorised distributors
disclaim all liability for any corruption of data, inability to
access data, loss of data, breach of privacy, or downtime as
a result of or arising from the use of any online link available
between the Software and another server including without
limitation in connection with Online Services.

On-line services: Reckon makes no warranty or representation
in connection with the Online Services, or third party
hardware (for example but not limited to Postec services) the
responsibility for which rests with the relevant provider of
such Online Services or such hardware.

8. TERM AND TERMINATION OF LICENCE

Licence Term: Unless this Licence is terminated earlier in
accordance with its terms, your right to use the Software in
accordance with this Licence continues:

(i) inthe case of a subscription version of the Software,
for an initial period of 12 months from the date
of registration of the Software. This Licence will
automatically renew for a further 12 month period upon
the payment of Reckon’s annual subscription fee. If
the annual subscription fee is not paid on or before the
termination of the current 12 month period, this Licence
will automatically terminate; and



(b)

(c)

(d)

(i) in the full version of the Software, indefinitely, however:

(A) you may be required to periodically verify your
licence details and have the Software reactivated as
per clause 3 in order to keep using the Software; and

(B) if you need to reinstall the Software, you will need a
copy of your original CD (or other media on which
the Software was provided) and the installation
key code. If you do not have the CD, you will need
to purchase or upgrade to a new full version and
pay for the postage associated with sending the
CD to you. Clauses 3(d) and 3(g) outline when
Reckon may charge you a fee for the provision of
a replacement key code and, more importantly,
when a replacement key code will not be provided
by Reckon due to the operation of Reckon’s sunset
policy.

Termination by Reckon for breach: Reckon may terminate this
Licence if you are in breach of its terms or as otherwise set
out in this Licence.

Survival: Clauses 2, 4, 6, 7 and this clause 8 will survive the

termination of this Licence. Termination of this Licence will
not prejudice any right which Reckon may have, or but for
the termination may have had, against you for a breach of
this Licence.

Things you must do on termination: Upon the termination

of this Licence, you or your representative must promptly
uninstall the Software from your computer, destroy the CD,
User Guide and related materials and any copies of them

in your possession or control or return or dispose of them

in the manner directed by Reckon. Upon written request
from Reckon you agree to provide a Statutory Declaration to
Reckon that you have complied with your obligations under
this clause 8(d).

9. SUBSCRIPTION TERMS

If you have purchased a subscription version of the Software, this
additional clause 9 will apply.

(a)

(b)

Entitlement to Upgrades and Updates: During the period

for which you have paid subscription fees you will receive,
included in the cost of the subscription, all Upgrades and/or
Updates of the Software, via Internet download.

No extension of Licence term: Your right and entitlement to
use the Software, as enhanced by any Upgrades and/or
Updates, concludes at the end of the term of the Licence
(subject to payment of an annual subscription fee) and is not
linked to the dates of release, registration or provision by
Reckon of any Upgrades and/or Updates.
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(c)

(d)

(e)

(f)

(9)

(h)

(i)

This Licence prevails: If you have purchased this Software as
an Upgrade to an earlier version of the Software, this Licence
shall supersede any previous licence agreement.

Not all Upgrades included: Your subscription to the Software
and any Upgrades and/or Updates under this Licence does
not grant you the right to receive special versions of the
Software created for certain customers or market segments,
even though they may contain similar features or functions.
Versions of the Software which may from time to time be
offered in retail or other channels in different configurations
as special promotions are not included as part of the
subscription.

No obligation on Reckon to upgrade: Upgrades and/or
Updates will be developed and released by Reckon in its sole
discretion, and Reckon does not warrant or represent that it
will develop or release any Upgrades and/or Updates during
the term of the subscription period or Licence. Furthermore,
Reckon does not warrant that the Upgrades and/or Updates
will be provided to you or made available within any
specified time period following the commercial release of
such Upgrades and/or Updates.

When payment is due: If applicable to the Software licensed
to you, you will be required to pay the monthly subscription
fee in advance on the first business day of each month. You
authorise Reckon to direct debit your monthly subscription
fee from the bank account nominated by you.

Deactivation at end of subscription period: As per clause 3, the
subscription version of the Software is provided to you on
the understanding and acknowledgment that it may contain
technology which deactivates and disables the software

if your subscription is not renewed or you are found to be

in breach of this license agreement If the Software is not
renewed by the end of the required period, the Software
may continue to operate but with impaired functionality or
you may not be able to access the Software at all (including
printing out or viewing any of your data or records).

You need a full version if you don’t renew: If you elect not to
renew your subscription, the Software does not allow you
to upgrade to a non-subscription version of the Software
by way of the purchase of an Upgrade pack. In such
circumstances, you are only able to upgrade to a later non-
subscription version of the Software by purchasing a full
(non-upgrade) version of the Software.

Early termination: If you wish to terminate your subscription
early, you must do so by giving Reckon no less than one
calendar month notice to that effect. Depending on the
type of software you have subscribed to and the type of
subscription you are signed up for, you may be required to



pay a cancellation fee. See http://www.quicken.com.au for a
schedule of fees. Reckon will direct debit your account, and
you agree to pay, the applicable cancellation fee.

10. TRIAL LICENCE

If you have been provided with a Trial Version of the Software, this
clause 10 sets out the terms that will apply to your use of the Trial
Version.

(a)

(b)

(c)

(d)

Licence: Your licence to use the Trial Version:

(i) permits you to evaluate the Software’s functionality and
suitability for your requirements; and

(i) is for the number of users set out in the material
accompanying your copy of the Trial Version;

(iii) is subject to the general restrictions in clause 2(e) and
the limited warranty in clause 6(a); and

(iv) is for three months (Evaluation Period).

Duration: You acknowledge that your licence to use the Trial
Version will only apply for the Evaluation Period. At the end
of the Evaluation Period:

(i) you must not and will not be able to continue to access
the Trial Version, including any data that you have
entered into the Trial Version; and

(i) if you wish to use the Software you must purchase a full
version or subscription version of the Software.

Entitlements: You:

(i) arenotentitled to Upgrades or Updates (or any other
software other than the Trial Version); and

(i) may be required to pay for any technical support
that you may require in relation to the Trial Version in
accordance with Reckon’s then current charges.

Liability: You acknowledge that subject to clauses 7(b) and
7(c), and to the full extent permitted by law, Reckon excludes
all liability to you for any loss, damage, liability, costs or
expenses suffered by you relating to the performance or
non-performance of the Trial Version or any breach of this
clause 10.

11. STUDENT EDITION

(a)

If you are using a Student Edition, your Software may

have limited licence rights as well as limited functionality,

including:

(i) alimit on the number of transactions that can be
entered;

(ii) alimit on the number of company files that can be
opened;
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()

(d

(iii) a limit on the number of QuickBooks features and
services available.

Your Software may be deactivated at the end of three years
from date of installation and this may prevent access to
the Software and data unless an appropriate upgrade is
purchased.

There is no support available for Student Edition. Support
must be directed to your educational institution.

Reckon does not warrant that any information in the
Software is up to date, for example functionality required
for certain lessons involving tax tables or payroll tax, and it
is your sole responsibility to check with your educational
institution whether any information is up to date.

12. GENERAL

(a)

(b)

(c)

(d)

(e)

Some defined terms: In this Licence:

Trial Version means Software that has been provided to

you on a temporary basis in order to carry out a trial of that
Software to determine whether you wish to use the Software
on an ongoing basis.

Student Version means Software that is licensed to you as
part of your educational institution’s arrangement with
Reckon or Software that you have purchased that Reckon
has determined is a Student Version.

Upgrade means a new version of the Software which
contains additional functionality or other enhancements.
Reckon will determine whether a new version constitutes an
Upgrade or an Update.

Update means a new version of the Software which contains
minor enhancements.

Applicable law: This Licence is governed by the laws of the
State of New South Wales, Australia.

Entire Agreement: This Licence contains the entire agreement
between Reckon and you in relation to its subject matter
and supersedes any prior agreements and understandings,
whether written or oral.

Waiver: Any failure to enforce any rights under this Licence
by Reckon is not to be taken as a waiver of those rights.

Variation: To the extent permitted by law, Reckon may
vary any of the terms and conditions of this Licence upon
providing you with thirty (30) days notice in writing and a
copy of the replacement terms and conditions. In the case
of subscription users no new terms will come into force
until the commencement of your renewed subscription
period. Reckon will display any new terms and conditions



on Reckon’s web site and you should check the QuickBooks
website regularly. See http://www.quicken.com.au.

(f) Headings: Clause headings are for ease of reference only and
do not affect the meaning of this Licence.

Quicken and QuickBooks are registered trademarks of Intuit Inc.
Software is © 2008 -2009, Reckon Limited.

All rights reserved.
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Product updates available online

Reckon regularly posts product news, announcements,
and other information of interest to Customer Manager
users on our website, www.quicken.com.au.

From the website, you can download product-related
files, such as software service packs and product updates.
To keep your software secure and up-to-date, visit the
website regularly.

You must be a current Advantage or Subscription
customer, using the latest version of the software, in order
to access these files. This also applies to replacement
updates if they are lost, for example, due to a hardware
failure. To avoid potential problems, be sure to keep your
Annual Membership up to date.

Store your Customer Manager
products safely

Your unique Licence Key and Customer Manager CD are
extremely valuable and may be required to reactivate or
reinstall the software. Please keep your Licence Key in a
safe place with your Customer Manager CD. If you lose
your Licence Key or CD, they will be replaced only while
this version is supported, and administrative charges may

apply.



Your important reference numbers

Customer ID:

Customer PIN:

Licence Key:
Installation | Computer/ Serial Number Registration
User Number
Example Recention 1234-1234-123- 1234-1234--
P P 1234-1234 1234-1234
PC1

You will need these numbers for re-registration purposes.

Please have these details on hand when contacting Reckon.

To find the Serial number in Customer Manager:
« Go to the Help menu, click About

To register Customer Manager online:
1. Go to File menu and click Register Product...
2. Click Online button

My original Customer Manager CD is safely stored here:
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Contacting Reckon
Technical Support

Australia

For installation and software support, Technical Support
is available Monday to Friday, 9.00am — 5.00pm AEST.
Weekend support is also available, check website for
opening hours. Extended hours are available to Reckon
Advantage members.

e Reckon Technical Support: 1902 223 101

Call costs $4.90/min (incl GST).

« Charges are higher from public and mobile phones.

« Call costs and operating hours are subject to
change.

www.quicken.com.au/support

New Zealand

Technical support is available Monday to Friday,
9.00am - 5.00pm NZ.

e Per incident support 0800 933 666
$35.00 plus GST

Per minute support 0900 33 609

Call cost - $3.95 /min (incl GST)

Charges are higher from public and mobile phones. Call
costs and operating hours are subject to change.

www.quicken.co.nz



